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1  INTRODUCTION 
BWSpec® 4 is a Spectrometer Data Acquisition and Analysis Software Program. It supports three types of 
B&W Tek spectrometer interfaces: RS-232, USB 2.0, and USB 3.0.  



 

 
 290020235-P    |   (9/10/24) Copyright 2024 B&W TEK Page 4 

2  INSTALLATION 
Refer to “BWSpec Software and Hardware Installation Guide” for fully detailed installation 
instructions: You may consult IT department for support. 
 

 Operation system 

Windows 10 (32 bit & 64 bit) 
Windows 11 64 bit  
Administrator Windows user privilege for installation 

  Hardware Requirements* 

Meets or exceeds the System Requirements for your PC’s Operating System respectively 
Processor: 1.5GHz or faster 
RAM: 4GB or more 
Hard disk space: 500MB available or more** 
 
* The requirements are for normal use and do not include resource intensive features like Burst Mode 
** Additional hard disk space may be required to store generated data by the application. 

  Prerequisites 

Internet access is not required for automatic installation of .Net Framework. 
.Net Framework 4.8 or higher is required. 
 

 Installation Procedure 

• For computers with BWSpec already installed, it is highly recommended to uninstall the existing 
one and execute the following steps.  

• Locate BWSpec software installation package and copy the entire package to local computer. 
Installation through network is not recommended and success is not guaranteed. 

• Locate proper setup.exe from either 32bit or 64bit subfolder, double left click to begin the installation 
process. User must have administrator rights for installation. 

• After software installation, DO NOT open the BWSpec program.  
• Connect the spectrometer to the PC via a USB Cable. 
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• Install the Hardware Driver(s) for the spectrometer. 
• After hardware driver installation, open/run the BWSpec program. 



 

 
 290020235-P    |   (9/10/24) Copyright 2024 B&W TEK Page 6 

3  RUN BWSPEC 
Double click the BWSpec icon on the desktop:   

 
If the User Account Control is active, the following message will appear:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click Yes to continue. 
 
The Workspace Setup window will open, prompting the user to choose a workspace based on their unit 
and application. 

 
 
 
 
 

 
 
 

 
 
If you are unsure, choose the default BWSpec workspace and click Set. This option may be changed later 
within the main program; Setup  Workspace. 
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4  MAIN WINDOW 
 
Presented below is a brief visual overview of the BWSpec 4 main window. The main toolbars, panels and tabs 
are highlighted; refer to the corresponding section for more detailed information.  
 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu 
Toolbar 

Spectrum  
List Panel 

Spectrometer 
Control Panel 

Spectrometer Information Panel 
Status  
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5  MENU BAR 
  
 
The following sections are detailed descriptions of the dropdown menus available for each menu option in the 
BWSpec 4 Menu Bar.  

6  FILE 
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 Open Spectrum…  
 
Load a previously saved spectral file into the main graph. 
Available in the following formats: 

TXT File (*.txt) including BWSpec TXT and simple TXT 
TXTR File (*.txtr) 
CSV File (*.csv) including BWTek raw CSV, LIMS CSV and simple 
CSV 
SPC File (*.spc) with XY two series data which could be saved through BWSpec or from other instruments 
and software 

 

 Save Selected Spectrum…  
 
Save the spectrum selected in the Spectrum List Panel. 
Used to save data of selected spectrum from BWSpec in the following formats: 
*.TXTR – this is set as default - .TXTR files contain information about the spectrometer, acquisition 
parameters, data processing, applied Ratio 1, 2, and 3, and data from all axis types. This file type includes 
the most information and can be saved as all other data formats. 
*.TXT - .TXT files contain information about the spectrometer, acquisition parameters, and data from all axis 
types. 
*.CSV - .CSV files contain information about the spectrometer, acquisition parameters, data processing, 
and data from all axis types. Compatible with Microsoft Excel. 
*.TXT(Linear) – same as .txt. However, the user may choose ‘Save only the selected X and Y axis data’ 
which will not contain any additional information.  
*.SPC – data is encrypted. SPC files are compatible with other Raman software 
*.Simple TXT – contains only one set of x-axis data in Raman Shift (cm-1) and one set of y-axis Dark 
Subtracted (Processed) data. 
*.Simple CSV – same as Simple TXT 
*.Simple SPC – same as Simple TXT 
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 Save All Spectra As… (Manually)  
 

Saves all spectra in the Spectrum List Panel individually.  User can change save name and file type for 
each spectrum.  A new Save Spectrum Data window will open for each spectrum. 

 

 Save All Spectra… (Automatically)  
 

Saves all spectra in the Spectrum List Panel at the same time.  The data will be saved with the name 
shown in the Spectrum List Panel. All files will be saved as the same, user-selected file type. The active 
spectrum must be .txtr, .csv, or .txt formats or a measured spectrum for this feature to be enabled. 
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 Export Data  
 

This requires plug-in turned on in Plug-In > Plug-In Manager: 

 

 Export Data Plug-in  

The Export Data Plug-in gives the function to export all spectral data into one text file.  
Location: in the Menu Bar  File, choose Export Data→ Export All Spectra Data to One TXT File. 
Select the data information to be exported, and click Save As.  
All selected Spectra will be exported and saved to a text file. The active spectrum must be .txtr, .csv, or .txt 
formats or a measured spectrum for this feature to be enabled. 
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 Set Auto Save Data File…  
 
 
 
 
 
 
 
 
 
 

This is the setting to automatically save all scanned data to a designated folder. 
When this is enabled, all functions under Tools are disabled. 

When this is enabled, dark scan is mandatorily required for this first scan and when integration time is 
changed. 
When this is enabled, Reference button is disabled. 

 

 Timeline Load…  
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This function allows user to re-run previously saved Timeline series with the ability to re-define data processing 
and analysis. May be used with Batch Re-Process to reprocess the data as it loads into BWSpec. 

 Excel   
Export the active/selected single spectrum from the Spectrum List Panel to an Excel sheet.  
The active spectrum must be a Measured spectrum or BWSpec TXT or TXTR format if it is an opened 
spectrum. 
Only one active spectrum can be exported to Excel at one time. 
Data is opened in Excel when the export is successful. 
Compatible with all Excel versions. 

 Print…   
Show Print Preview window with the displayed data and header information for the active spectrum. 
Add watermark, Save As, Print and etc. 

 File Convert…   
Convert all spectral files of the same format under a selected folder into another format. 
Convert BWSpec4 *.txt files to BWSpec4 *.txtr file type.  
All three Ratio files for the same instrument the data was collected on must be loaded for the conversion to 
have the corrections applied. 
Any processing done in the *.txt file is not recorded in Data Pretreat section. 
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Convert BWSpec4 *.txtr files to BWSpec 4 *.txt file type. 

Convert BWSpec3 data files which may contain multiple spectra (up to 3) into individual BWSpec4 
compatible files.  

 
 

Convert BWSpec3 file format to BWSpec4 
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 Exit   
Closes the BWSpec program.  
You will be prompted to save any unsaved or modified spectra.  
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7 VIEW 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 Show In Overlay 

When viewing more than one spectrum, an overlay of each spectrum in the Spectrum List Panel will be 
displayed in the main graph. 
When enabled (default) a green checkmark is shown. 
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 Show In Sequence 

When viewing multiple spectra, individual graphs will appear in the order they are listed in the Spectrum 
List Panel. 
When enabled, a green checkmark is shown. 
Show in Overlay and Show in Sequence are mutually exclusive options. 

 
 

 Clear All Spectral Data… 

Remove all spectra from the Spectrum List Panel and display area. 
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 Display Scales… 

The Display Scales Setting window shows the graphing window’s X-axis and Y-axis settings. 
X-axis scale settings are based on the default calibration settings for the spectrometer. 
Using Automatic Scales will auto-adjust the graph and axis to fit the current displayed data. 
While using Manual Scales, the X-axis may be changed by typing in a Minimum and Maximum into the 
boxes, or by moving the slider for the Left Position and Right Position.  
Check the X-axis Apply for All Spectra to apply changed settings to all spectra in the Spectrum List 
Panel. 
Click the Set button to apply the selections to the graph. In the X-axis, the selection will be applied to the 
nearest pixel. 
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 Custom Setting 

 
Display settings for the main graph window. 

 
Spectra Color Setting… 
Opens a Spectra Color Settings window where the spectrum color order for overlays can be set / adjusted. 
The sequence is based on spectra listed in the spectrum list panel. 

 
 
Spectra Graph Setting… 
Opens a Graph Setting window where the variables 
relating to the graph window display can be set and 
adjusted to create a customized graph. 
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 Spectrum List Panel 

There are two types of spectra: Measured spectra and Opened spectra. Measured spectra are data files 
just collected from online instrument. Opened spectra are loaded offline data. 
Toggles On/Off display of the Spectrum List Panel on the right side of the display. 
Spectrum with the flag symbol before the name is the “active” spectrum. 
The most recent active measured spectrum will be overwritten if a new single scan is taken (Acquire One 
Spectrum) 
A new measured spectrum will be added to the list if an Overlay scan is taken (Acquire Overlay) 
Dark and Reference scans will be updated to active Measured spectrum. 
Expanding the + will give information on the spectrometer and settings used to collect the spectrum. 
When enabled (default) a green checkmark is shown. 
Refer to Spectrum Information Panel for more details. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Right-click menu: 
Select a spectrum name and then right click. Menu appears with the options:  
Rename Selected Spectrum (rename the selected spectrum without saving it), Remove Selected Spectrum 
(deletes the selected spectrum from the Spectrum List Panel) , Remove All Checked Spectra (deleted all 
spectra from the Spectrum List Panel that have a checkmark next to them), Remove All Unchecked Spectra 
(deletes all spectra from the Spectrum List Panel without a checkmark next to them), Enable / Disable 
Spectrum Thick LineWidth (changes the line thickness of the spectrum trace), Change Laser Excitation 
Wavelength (user can manually adjust the laser wavelength from what it was set to at the time of acquisition). 
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 Spectrum Information Panel 

Toggles On/Off display of the Spectrum Information Panel. 
Displays spectrum details including spectrometer and laser information. 
Any processing steps used are listed in the Pretreat_# section 
When enabled (default) a green checkmark is shown. 
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 Spectrometer Control Panel 

Toggles On/Off viewing of the Spectrometer Control Panel. 
The availability of the listed options depends on the Workspace selected.  
When enabled (default) a green checkmark is shown. 
 

    BWSpec Workspace       Raman Workspace 

  



 

 
 290020235-P    |   (9/10/24) Copyright 2024 B&W TEK Page 23 

8 ACQUISITION 
         
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Acquire One Spectrum   
Acquires a single spectrum from the spectrometer and displays it on the graph. 
The data is viewable on the Raw Data Y Axis Type. 

 Acquire Overlay   
Acquires a single spectrum and displays it over top of the previously displayed spectra.  
Note that the previously taken spectra can no longer be edited.  
The data is viewable on the Raw Data Y Axis Type. 

 Acquire Continuously   
Data is continuously displayed in the graph from the spectrometer with no delay between scans. The data 
is viewable on the Raw Data Y Axis Type. 

 Stop   
Stops acquisition while using Acquire Continuously. 
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 Acquire Dark   
Acquires a single spectrum which is stored as the Dark array.  
The Dark array is viewable in the Dark Y Axis Type. 

 Acquire Reference   
Acquires a single spectrum which is stored as the Reference array. 
The Reference array is viewable in the Reference Y Axis Type. 

 Acquisition Tips 

A Dark Spectrum is used to subtract the contribution (dark noise) of the sensor itself or noise from 
environment. This is carried over until a new dark spectrum is acquired. Every time when integration time 
and/or average are changed, dark spectrum must be collected again. 
A measured spectrum is unfinished when it is just acquired. It becomes Finished after it is saved or after a 
new spectrum is measured.  
To ensure data integrity, BWSpec prevents the measurement of a new spectrum when the last measured 
spectrum is unfinished, for example, when in Raman Workspace, the integration time of the signal and the 
dark spectrum are not the same. If you are unsure if the raw and dark integration times same, attempt an 
Acquire Overlay. If they have different integration times, BWSpec will alert the user that the integration 
time of the raw and dark do not match. 
Use the Auto Dark feature in Hardware Setup  Common to take a Dark scan after each Acquisition. 
If the last Measured Spectrum is unfinished and is selected, it can be overwritten by a new measurement. 
No other spectrum can be overwritten by a new measurement except a new spectrum. 
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9  SPECTRAL FUNCTION 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Items under Menu -> Spectral Function are: 
• Enable / Disable Linearity Correction 
• Enable / Disable Irradiance Calibration… 
• Enable / Disable Reference Material Correction… 
• Enable / Disable Relative Intensity Correction… 
• Baseline Removal… 
• Smoothing… 
• Derivative… 
• Batch Process… 
• Spectra Math 
• Peak Analysis… 

Since the Raw Data, Dark, and Reference data are protected, functions that alter the data are 
disabled if the active Y Axis Type is set to one of these types. Such functions include Baseline 
Removal, Smoothing, Derivative, Batch Process and Spectra Math. Peak Analysis does not alter 
the data and is enabled on these Y Axis Types. 
 

Please note that the ability to use certain functions may be superseded if Experiment is enabled. 
Check the loaded Experiment configuration file for details if it is enabled. 
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 Linearity Correction 

Linearity Correction will compensate for the detector array’s nonlinear intensity response by following a 
fitted response curve against received detector photons. 
A typical detector array may exhibit a nonlinear response with respect to incident photons at low light levels 
as well as when close to saturation. In these regions, doubling photons or doubling detector exposure time 
will no longer result in two times the detector’s output, deviating from a desired linear response range. 
Linearity Correction must be conducted by the factory in order for the Linearity Correction Coefficients to be 
saved into device EEPROM. Refer to section under Menu->Tools for details if interested. “Linearity 
Correction” is a service option to be ordered when purchasing the spectrometer or through a service request. 
Linearity correction can be configured in Menu->Spectral Function->Enable/Disable Linearity 
Correction…or in Experiment Setup.  
In the menu, Linearity correction is off by default and can be enabled when instrument is online: 
 
 
 
 
Linearity coefficients are read from spectrometer EEPROM. 
When it is enabled, status on the bottom will show Linearity Correction is ON. 

 
 
 

  

 Irradiance Calibration 

This calibration is to convert the spectrum response from relative intensity to absolute photometric response 
for measurement of photometry and colorimetry for a light 
source.  
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Irradiance Calibration can be configured in Menu->Spectral Function->Enable/Disable Irradiance 
Calibration…or in Experiment Setup. To enable this calibration, user has to load file ratio1_xxx.txt where 
xxx is cCode of spectrometer. 
When Irradiance Calibration is enabled, after a scan has been taken, click “Absolute Irradiance” on the 
Spectrometer Control Panel. The Absolute Irradiance curve will show on the display. 
You may need to adjust the X-axis and Y-axis scales in order to get a suitable display scale. 
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 Reference Material Correction  

In applications such as diffuse reflectance measurements, a certified reflectance standard is often used to 
serve as a reference. The %R values throughout the measurement range are then calculated by using ratios 
with respect to the reference in a relative sense. With the available certified %R values, the BWSpec 
software can calculate the “absolute reflectance” against the reference. 
The following is a table of typical %R values obtained using a certified white PTFE type material spectral 
reflectance standard (B&W Tek model number SRR-1.25-99 or SRR-2.0-99). 

Wavelength (nm) Certified %R value  Wavelength (nm) Certified %R value 

360 98.5 600 98.9 
370 98.7 610 98.9 
380 98.7 620 98.9 
390 98.7 630 98.9 
400 98.8 640 98.9 
410 98.8 650 98.9 
420 98.8 660 98.9 
430 98.8 670 98.9 
440 98.8 680 98.9 
450 98.8 690 98.9 
460 98.8 700 99.0 
470 98.8 710 98.9 
480 98.9 720 99.0 
490 98.9 730 98.9 
500 98.9 740 98.9 
510 98.9 750 99.0 
520 98.9 760 98.8 
530 98.9 770 98.9 
540 98.9 780 98.9 
550 98.9 790 98.9 
560 98.9 800 99.0 
570 98.9 810 98.9 
580 98.9 820 99.0 
590 98.9 830 98.9 

If we define %Rs (non-correction) as the sample percent reflectance at a given wavelength: 
%Rs (non-correction) = (Sample intensity/Reference intensity)*100. 
 
After reference material correction: 
%Rs (absolute) = %Rs (non-correction) * Certified %R value/100 where all values are calculated at given 
wavelengths across the calibration wavelength range. 
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Reference Material Correction can be configured in Menu->Spectral Function->Enable/Disable Reference 
Material Correction …or in Experiment Setup. To enable this correction, user has to load file ratio2_xxx.txt 
where xxx is cCode of spectrometer. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Relative Intensity Correction  
Relative Intensity Correction is specific for Raman spectrometer users. Its purpose is to correct unique 
relative spectral responses against a traceable standard for individual spectrometers. The corrected spectral 
response of a Raman spectrometer makes meaningful comparisons between data obtained from different 
instruments possible.  
The Relative Intensity Correction involves the use of Standard Reference Material 2241 (SRM 2241) for 
Raman spectrometers when a 785nm excitation laser source is used, SRM2242(the latest is SRM2242a) 
when a 532nm excitation laser source is used and SRM2244 when a 1064nm excitation laser source is 
used. Refer to website for more details: SRM Definitions | NIST 
Relative Intensity Correction can be configured in Menu->Spectral Function->Enable/Disable Relative 
Intensity Correction …or in Experiment Setup. To enable this correction, user must choose probe to load 
file ratio3_xxx.txt where xxx is cCode of spectrometer. 
 

https://www.nist.gov/srm/srm-definitions
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To change the Relative Intensity Correction setting of saved spectra, use the Batch Re-Process function. 
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 Baseline Removal   
The Baseline Removal function is used to perform baseline correction. This helps remove spectrum 
background to correct for fluorescence, baseline curvature, noise, or ambient light.  
This function is disabled when the Y Axis Type is set to Raw Data, Dark, or Reference. 
 
A display window with three spectra will be displayed: raw spectrum (red), automatically fitted background 
curve (black), and the spectrum after background removal (blue). The color of the raw spectra reflects its 
color in the Spectrum List Panel. 
The lambda factor can be adjusted by moving the slider bar at the top, or by typing in the Lambda box. This 
manipulates the auto fitted background to achieve the desired baseline removal result. Click Do to apply 
changes to the main graph.  
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 Smoothing…   
Opens a Smoothing window for applying smoothing processing to all Checked spectra. 
This function is disabled when the Y Axis Type is set to Raw Data, Dark, or Reference. 
When clicked, a Smoothing Panel will appear on right panel: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

FFT (Fast Fourier Transform) 
FFT Smoothing can be applied to the original spectrum using a smoothing factor of 1-99%.  
The smoothing factor needs to be carefully selected so as not to cause a distorted spectrum. 

 
Savitzky-Golay Smoothing 
Savitzky-Golay Smoothing can be applied to the original spectrum with a window size setting from 2-5. 
This is a commonly used smoothing method with less chance to cause distortion and degradation to the 
spectral resolution. A higher window size causes a greater degradation to resolution. 

 
Boxcar Smoothing 
Boxcar Smoothing can be applied to the original spectrum using a “window size” setting from 1-1023.  
The smoothing function will apply the forward moving smoothing by taking the average of the specified 
number of pixels plus one pixel to the left of the group and one pixel to the right of the group.  
This is an effective smoothing operation that comes at the expense of degraded spectral resolution; hence, 
do not use a larger than necessary window size setting to preserve the needed spectral information. 
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 Derivative…   
 
Opens the Derivative Control Panel for applying derivatives to all displayed spectra. 
This function is disabled when the Y Axis Type is set to Raw Data, Dark, or Reference. 
When clicked, the Derivative Panel will appear on right panel: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Point Diff: This computes the first derivative of the spectrum by the difference in the y response 
between two points on the x-axis. 
Savitzky-Golay: the user can choose the derivative order, the degree (of the polynomial fit), and the 
number of points over which to compute the derivative. 
Differential: the user can set the point interval to use from 5 to 20. 
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 Batch Process   
 

 
Batch Process works like Experiment Setup but used to process or re-process loaded spectra in the 
Spectrum List Panel. Check to ensure only loaded spectra of the same file format are loaded for the best 
experience.  
This function starts with the Raw Data (Raw and Dark in the file) of each spectrum. Each checked spectrum 
is processed according to the steps specified and the results are saved in the corresponding Processed 
Data block (called Dark Subtracted in the file). All other Spectral Functions start with the Processed Data 
block of each spectrum, performs the chosen function, and saves the results.  
For example, if a Spectrum has previously been intensity corrected and smoothed, performing Spectral 
Function/Derivative on it will produce Processed Data that is intensity corrected, smoothed and then 
differentiated. Performing Batch Re-Process with “Enable Relative Intensity Correction” unchecked and a 
derivative step defined in Spectral Processing/Additional will produce a Processed Data that is differentiated 
on the Raw Data. These are reflected in the Pretreat sequence viewable in the Spectrum Information 
Panel. 
Because different file types contain different data, it is impossible to apply one set of Re-Process steps to a 
set of Checked Spectra of mixed formats. So, if different file formats are selected, upon clicking “Batch Re-
Process”, a warning message will display: “Selected Spectra are of different file formats. Please select 
spectra of the same format.” 
Spectral Processing includes both Instrumental Correction (found in Tools menu) and other spectral math 
functions. Some or all instrumental correction may be disabled due to file format. 
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If Checked Spectra are Measured spectra; when an Instrumental Correction requiring a ratio file is selected, 
the user must choose a Ratio file from disc. 
If Checked Spectra are Opened Spectra of TXTR format, then all Instrumental Corrections are allowed, and 
if an Instrumental Correction requiring a ratio file is selected, the ratio data stored in each spectrum will be 
used to process the corresponding spectrum. 
If Checked Spectra are Opened Spectra of TXT format, which does not have the ratio spectrum within, then 
all Instrumental Corrections are allowed, and if an Instrumental Correction requiring a ratio file is selected, 
the user must choose a Ratio file from disc. 
If Checked Spectra are Opened Spectra of SPC (*.spc) format, which does not have the raw data, then all 
Instrumental Corrections are disabled. Processed data will overwrite existing data. 
Analytics Settings may be imported from a currently loaded Experiment Setup configuration file using the 
Copy From Experiment button. 
The Re-Processed data may be automatically saved if Save Processed Spectra is checked.  
Click “Do” to execute the Batch Re-process, “Undo” to restore the original data. In case the Save Processed 
Spectra is checked, “undo” will also delete the files saved from the disc. 
Any configuration created between the Batch Re-Process function in Timeline Load and this function may 
not be cross compatible. It is recommended to create a new configuration file for each mode if both modes 
are to be used 
Refer to Experiment Setup section for details on processing features and a walk-through. 

 Peak Analysis…   
Information on peaks in the spectrum can be shown live in the software’s display window. 
Automatic Peak Identification: Peak position is accurately determined by curve fitting, instead of using 
the position of the highest pixel. 
In the top left-hand corner of the menu, input the value at Minimum Absolute Peak Height (threshold) and 
the Minimum Peak Width. All identified peaks are listed in the table.  
This table provides detailed information on the identified peaks.  
When Baseline Removal is checked, analysis results are based on the baseline subtracted spectrum. The 
Baseline corrected spectrum does not display or get applied. 
Check the box for Display Peak In Graph and the identified peaks will be marked on the spectrum. Select 
the information to display in graph by checking the desired items. 
Peaks may be added by checking Add a peak manually. Then go to the main graph and click and drag a 
box over the peak of interest. 
Peak can be removed by right clicking this peak line then selecting Delete This Peak. 
Select the Report Export button    to export table to an Excel sheet. 
Select the Print button    to print a Peak Analysis Report, containing spectrometer information, the graph, 
and table.  
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Select the Peak Field Setup in Print Report button     to change the field and to adjust the number of 
fields available in the Print Table. 

 

 Spectra Math   

This function provides the ability to perform math functions on one, or multiple spectra. 
Spectra math contains the following options: 
• One Spectrum Math 
• Two Spectra Math 
• Spectra Normalize to Constant Value 
• Spectra Normalize by Total Integration Time 
• Spectra Normalize by Unit Vector  
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One Spectrum Math… 

 
 

Two Spectra Math… 

 
 

Spectra Normalize to Constant Value… 
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Spectra Normalize by Total Integration Time… 

 
Spectra Normalize by Unit Vector 
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10  TOOLS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This menu provides a set of functions for instrument calibration and correction.  
Irradiance Calibration 
Laser Wavelength Calibration 
Linearity Correction 
Performance 
Raman Shift Calibration 
Reference Material Correction  
Relative Intensity Correction 
System Response Standardization 
Wavelength Calibration 

 Irradiance Calibration 

This option is available only in the BWSpec Workspace. A NIST-Traceable Irradiance Standard light source 
is required. Follow instructions on screen to create irradiance calibration file ratio1.  
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Irradiance calibration can be configured in Menu->Spectral Function->Enable/Disable Irradiance 
Calibration… by loading proper ratio1 file or configured in Experiment Setup. 

 
WARNING: This function is for advanced users only.  

 
o To conduct an Irradiance Calibration, you must first have a NIST Traceable Lamp Source with 

certified values which cover the spectral range you will be calibrating your spectrometer to and 
the .DAT file that accompanies your lamp.  

 
o It is also necessary to have the correct input optics for your spectrometer to collect the light, such 

as a fiber and an integrating sphere. 
 

o The spectral irradiance calibration will allow a spectrometer to convert spectral measurements to 
absolute spectral irradiance measurements in units of light power in W/ [cm2*nm], mW / [cm2*nm] 
or µW / [cm2*nm].  Alternatively, a spectral irradiance calibration can be used to calibrate the 
spectrometer for emissive photometric measurements, such as for the color of an emissive source 
(for example, LED). 

 
o Your setup conditions, distance from source, and lamp current must be as close as possible to what 

your NIST Certificate states to conduct a successful calibration. Ideally, the light source should not 
fill the spectrometer’s entire angular aperture. The light source should illuminate the spectrometer 
at a distance specified in the lamp source’s calibration data.  
 

o Given a correct experimental setup, the spectral irradiance calibration proceeds as follows with the 
assumption that the spectrometer is equipped with a suitable input optic (linearity correction is highly 
recommended): 
 

Step 1: Adjust the integration time so that the maximum spectral response is just below the spectrometer’s 
saturation level against the certified lamp at a specified distance. Stop the acquisition and freeze all physical 
setup with minimal disturbance.  
Step 2: Cover your light input aperture so that no light is gathered by your setup and take a Dark scan first. 
Then uncover the aperture and take a Raw scan. Select Dark Subtracted (Processed) Y-Axis Type to see 
the final data.  
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Step 3: go to Tools  Irradiance Calibration, click the Browse button and locate the lamp data file for the 
light source you are using for irradiance calibration. Your lamp data file must be configured in a way BWSpec 
can read it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 4: Input the distance at which your Calibrated Light Source was originally calibrated. This information 
can be found on your Certificate or the .DAT file. Be careful to select correct units to match the certified data 
provided in the reference certified lamp data file. 
Step 5: Choose either Regression or Interpolation to calculate Irradiance Ratio file.  
Step 6: Select Use Current Spectrum to use Dark Subtracted (Processed) data for calculation.  
Step 7: Select the distance between your input optics and your certified light source in your current setup. 
Also, make sure to enter all calibration related information, such as additional optics used, into the dialog 
box.  
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Step 8: Input transmittance of neutral density filters. 
Step 9: Indicate the name of the ratio file and where you would like the data to be saved. We suggest that 
you keep the default naming scheme of the spectrometer (Ratio1_C-code). Set the ratio file path which is 
the Location where the ratio file will be saved. 
Step 10: Click Create to generate the Irradiance Ratio File. 
 

 Laser Wavelength Calibration   
Laser Wavelength Calibration uses the peaks of cyclohexane to calculate the exact wavelength of the laser. 
Laser wavelength can be entered manually in the Laser Wavelength Calibration panel or in Hardware Setup > 
Laser Setup tab. 
Press Calibration to open the Calibration screen. Place cyclohexane in front of the probe and press Calibration 
to begin. User can then Update Setting to the new wavelength value or Reject the change. 
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 Linearity Correction   
• Linearity correction will compensate for the detector array’s nonlinear response by following a fitted 

response curve against received detector photons.  
• A typical detector array may exhibit a nonlinear response with respect to incident photons at low light 

levels as well as when close to saturation. In these regions, doubling photons or doubling detector 
exposure time will no longer result in two times the detector’s output, deviating from a desired linear 
response range.  

• Location: Menu Bar  Tools  
• Linearity Correction must be conducted by the factory for the Linearity Correction Coefficients to be saved 

into device memory. “Linearity Correction” is an upgrade option to be ordered when purchasing the 
spectrometer or through a service request.  

 
Activate Linearity Correction  
• To activate linearity correction, go Setup > Experiment Setup and enable the checkbox. Linearity 

Correction only applies to Dark Subtracted (Processed) Y-Axis Type.  
 
How to Conduct Linearity Correction  
• For Advanced users, the linearity correction may be conducted at the customer site.  
• From the Menu Bar, select Tools → Linearity Correction... The linearity correction window will appear. 

Follow Step 1 through Step 9 instructions in the window to proceed.  
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Spectrum  
• Displays the current spectrum based on the integration time at the top of the window.  
• The graph may be zoomed in or panned just like the main window.  
• Displayed is a Tungsten spectrum that has been attenuated to a Relative Intensity of ~2000 counts.  
 
 
 
 

 
Fit  
• Displays the fitting curve of the correction based on the Order (Step 9).  
• Red is the Original, Green is the Fit curve, and Blue is the Corrected 
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Normalized  
• Displays the output before correction  
 
 
 

 
Linearized 
• Displays the output after correction. 
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Residuals  
• Displays the percent difference between the corrected value and the real value of intensity.  
 
 
 

 
Check (Correction) 
• Displays the corrected Spectrum/Integration vs Time graph 
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Check (No Correction) 
• Displays the uncorrected Spectrum/Integration vs Time graph.  
 
 
Note: Once the Flash is re-read, the current active Linearity Coefficients will be lost. Linearity Correction 
conducted by the factory will have the coefficients saved in Flash.  
 
Note: The key for a successful linearity correction calibration setup is to provide a light input (Tungsten light 
source is suggested here) with adjustable intensity for the spectrometer to be calibrated so that the 
spectrometer shows a light response 500-1000 counts above its dark levels at its shortest integration time. 
This will provide the calibration with maximum useable dynamic ranges. 
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Performance…    
Performance is a function for all Raman instruments including laboratory Raman models. It is also applicable 
to DIY Raman setups but needs customized parameter settings. 
Performance function is used to create a PVR (performance validation reference) file which is the reference 
for the performance validation test. Each instrument should have its own PVR file. We recommend user to 
recreate the PVR file after hardware or calibration changes such as the replacement of sampling 
accessories, spectrometer and laser modules, new Wavelength Calibration, Raman Shift Calibration or 
Laser Wavelength Calibration. 
Performance validation implemented in BWTek software products is compliant with regulations from 
EP2.2.48, USP 858 and other related guidelines, and even more specifications are checked to have a higher 
control of system performance. 
Even if the product is not used in a regulated environment, performing a regular performance validation is 
still strongly encouraged to guarantee the performance and also the reliability of output results.  
Performance module is not available when status is offline. 

 
Create Reference File 
To create a PVR file, an instrument must be online. 
The connected model will be automatically 
identified and selected by the Instrument Model 
field. Instrument type will be Laboratory. Select the 
Reference Material used for the Reference file: 
Polystyrene, Acetaminophen, or Cyclohexane. 
Average and Laser Power can be set. Select the 
Probe to be used. Probe SN is not required.   
All parameters are set to default values but can be 
changed.  
When the Performance Precheck box is checked, 
Dark1, Dark2, and Dark(60s) scans will be taken. 
If unchecked, these dark scans will be skipped to 
shorten the time to complete PVR file creation. 
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Performance Validation  
After a PVR file has been created, Performance 
Validation can be run. Under Reference Name, 
select the PVR file to validate against. Select the 
connected probe from the Select Probe menu, 
then ensure the reference material is the same as 
what was used to create the PVR file. Press the 
blue play button to begin the Performance 
Validation. When complete, Pass/Fail results will 
appear in the Result section. 
The Performance Validation report can be printed. 
 
 
 
 
 
 
 
 

Performance Validation Record 
Previously completed Performance Validation 
records are saved and viewable here. Records are 
displayed according to the Date range selected. To 
view the results, click the name of the *.result file 
to be viewed. The report can be printed or 
exported as a .txt file, or the data can be exported 
as a .txt file. 
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 Raman Shift Calibration   
Raman shift calibration is performed when a performance test fails due to one or more peak positions are out 
of spec. A standard ASTM certified material Polystyrene is required for this calibration. 
When this calibration is done successfully, user can choose to save or reject. User can then click Update Setting 
to update local A-coefficient settings, Reject to reject the calibration result or Write EEPROM to update A-
coefficient in the device EEPROM.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Reference Material Correction   

Click   and browse to locate the “Reference Material ratio.txt” file. The default path is: C:\Program 

Files\BWTEK\BWSpec4\ratio\. This file contains the certified values of spectral reflectance over the 
wavelength range of interest.  After the file is loaded, the standard data will be populated. 



 

 
 290020235-P    |   (9/10/24) Copyright 2024 B&W TEK Page 51 

 
Follow the steps stated to fill out the parameters for the correction. The default ratio file name is Ratio2_C-
code.  
Click Create to generate a Ratio2 file. 
 

 Relative Intensity Correction   
This calibration comes standard with B&W Tek’s Raman systems.  
Determine the appropriate integration time: use the standard reference material SRM2241 (for 785nm), 
SRM2242a (for 532nm) or SRM 2244 (for 1064nm) to run a scan. The integration time of the scan should 
be adjusted to a value such that the highest intensity level is just below saturation level (65000 counts). 
Run a dark scan with the same integration time. For B&W Tek Raman systems, the laser turns off 
automatically when the dark scan is being collected. For modular Raman spectrometers, make sure the 
laser is off when a dark scan is being collected.  
Run a reference scan using the same standard reference material with the same integration time with laser 
turned on. 
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From the Menu Bar, select Tools > Relative Intensity Correction. The Relative Intensity Correction window 
will appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select the appropriate standard material (for example, SRM2241). 
Select Use Current Reference Data. 
Set the ratio file name and the path where the ratio file will be stored. 
Click the Create button. The Relative Intensity Correction file is created and the Ratio3 file is saved in 
the designated path.  
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 System Response Standardization 

Previously named “Laser Power Calibration” in BWSpec4.03. This Plug-In is not intended to be 
used by end users. System Response Standardization must be conducted by B&W Tek, certified 
Service Center, or Distributor equipped with specialized calibration setups. B&W Tek will not be 
responsible for any loss of your work and for any consequence if factory configuration is 
accidentally changed or corrupted. 
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 Wavelength Calibration 

This function is not intended to be used by end users. If your 
spectrometer needs calibration, please contact B&W Tek at 
www.bwtek.com. Wavelength Calibration must be conducted by 
B&W Tek, Distributors, or OEM customers equipped with 
certified and traceable Light Standards and specialized 
calibration setups. 
 
 
 
 
 
 
 
 

 

11  PLUG-IN 
        

 
 
 
 
Opens the Plug-In window, listing all the available software Plug-Ins. 
Check the box next to a given Plug-In to activate it. Click Apply and then OK to activate the Plug-In in the 
BWSpec Menu Bar. The Plug-Ins will be added to the appropriate menu on the BWSpec Menu Bar. The 
available Plug-ins depend on which workspace the user has selected. 

www.bwtek.com
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BWSpec:  
 
 
 
 
 
 
 
 
 
 
 
 
 
Raman:  
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 Timeline Plug-in 

The Timeline function provides automated, timed recording of acquired spectra and analysis results within 
the scheduled time interval parameters set by the user. These spectra are then saved into individual files 
and are displayed individually in the main graph. The data acquisition parameters such as laser power and 
integration time must be set in the main BWSpec window before entering the timeline dialog. 
If Dark and Reference spectra are taken before beginning timeline, they will be added to all additional 
timeline created spectra. 
Location: Menu Bar  Setup  Experiment Setup 

  
Enter settings, including interval time (the delay time between each spectral acquisition), number of scans, 
file name suffix and/or file name prefix, data format for saved files and save path. 
The spectra collected will be saved in the designated path. If no specific suffix is assigned, a default of _1, 
_2, _3 and so on will be assigned to each spectrum. 
When using Timeline, the regular Acquisition and Continuous Acquisition buttons are greyed out and 
replaced with the Timeline Acquisition button. 
The Main Graph will split into a Dual chart. The top graph will display the current Raw data and any overlay 
data. The bottom Chart will display Peak Monitoring as a function of time. 
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Note:  
Burst Mode is currently available on Exemplar series spectrometer models with USB3 connection. 
Connection of Exemplar models via USB2 can still be used for operation in Burst Mode but may result in a 
loss of performance such as limited Frames of spectra. 
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Timeline Load  
This function allows user to re-run previously saved Timeline series with the ability to re-define data 
processing and analysis.  
To automatically load the files that were saved previously, click File and select Timeline Load. Click Load 
path to select the folder location for the timeline data when the corresponding files are displayed on the 
Spectrum display panel. 
May be used with Batch Re-Process to reprocess the data as you load it into BWSpec. 

Note: Any configuration file created in Batch Process may not be cross compatible with this function. It 
is recommended to create a new configuration file for each mode if both modes are to be used 

To perform analysis and display results in lower chart, check Batch Process Setup and define the data 
processing steps and analytics as in Experiment Setup. For convenience, some settings can be copied from 
the current Experiment Setup and then edited.  
Location: Menu Bar  File 

Click the   button to automatically load each data file from the folder into the Spectrum List panel 

sequentially. If Batch Re-Process Setup is checked, each loaded spectrum will have the Batch Re-Process 
applied 

Click the  button to manually load the spectrum file forward, one at a time. 

Click the  button to manually load the spectrum file backwards, one at a time. 

Click the  button to resize the Timeline Load window. 

Click File type to select a saved file format.  
Display Spectrum Overlay shows each loaded spectrum in the chart together instead of one at a time. 
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12  SETUP 
 
 
 
 
 
 
 
 
 
 

 Workspace 

 
The Workspace Setup window allows switching between the BWSpec and Raman workspaces. 
The Raman Workspace has configurations and rules tailored for Raman applications in the Spectrometer 
Control Panel. 
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 Flash Access… 

The Flash Access window provides unique information pertaining to the defaults and settings of the 
spectrometer. 
Clicking the Read Flash button reads the spectrometer’s EEPROM (device memory) and resets the 
BWSpec variables back to their default factory values which include wavelength calibration, display scales, 
and linearity correction. 
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 Hardware Setup   
This menu is active only when status is online.  
Not all features in this manual are applicable to any spectrometer. Check product’s user manual for details. 

 
• Spectrometer info: 

This is to display spectrometer info of the online instrument. Values can be revised and saved to 
EEPROM with password. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

• Common Setting: 
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• Laser Setup: 

 
 

• Probe Setup: 
The Probe Setup Tab is to pre-configure probes for the system and defines which Raman Probe is available 
in the Experiment Setup. 
Select the Relative Intensity Correction ratio file provided on the BWSpec Installation flash drive. If you are 
missing your Ratio3 file, you may request a copy by contacting us at www.bwtek.com 
The Ratio3 information will now be displayed, Click Done to accept. 
You may use the Ratio3 created at the factory or you can create your own. Experienced customers can 
refer to the Relative Intensity Correction section for more details. The appropriate Standard Reference 
Material is required to create a good Ratio3 correction file. 
EEPROM Slot Setup: Do not use this feature. 

 
 
 
 
 
 
 
 
 
 

 

www.bwtek.com
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• Aux Port: 
 

 

 
Spectrometer configuration: 
Optional configurations for different hardware types. Check product user manuals for operation 
details. 
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 BAC151C Camera   
Turns on the BAC151C camera  
Refer to the BAC151C User Manual for details on installation and use. 
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 Experiment Setup   
Experiment Setup can be viewed from the Raman Workspace: 

 
Allows the user to create and save a set of parameters to define how data is collected and saved. This 
includes Acquisition, Spectral Processing, Analytics, and Timeline. 
Load Config loads a previously saved Experiment Setup. 
Save Config saves the current Experiment Setup. Changes made to the current setup are lost unless they 
are saved. 
Clear Config deselects the Enable Experiment box and resets any selections in the Experiment window. 
Current Config. File is highlighted yellow if any change is made and has not been saved. 
Changes made to the parameters are applied when the new configuration is saved; the acquisition 
parameters shown in other places will change accordingly. 
These Spectral Processing and Analytics are applied to Dark Subtracted (Processed) Data.  
There is checkbox to enable/disable Experiment. When it is checked, all setting parameters defined 
in Spectral Function will be overwritten by those from loaded Experiment config file unless not 
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defined there. 
 
 
 
 

Acquisition: 
Define the settings the instrument will use in each acquisition; including integration time, number of 
averages used for all instruments, laser power and probe used for Raman.  
A probe can be easily selected from a list of probes pre-configured in Setup=> Hardware Setup=> Probe 
Setup. 
For Raman instruments, a Probe must first be enabled/selected to enable Spectral Processing. Refer to 
the Hardware Setup section for more information on Probe Setup. 

 
Spectral Processing: 
This section is used to define which data processing should be performed. 
Options for intensity correction include: Linearity Correction, Irradiance Calibration, Reference Material 
Correction, and Relative Intensity Correction. 
Relative Intensity Correction is the only option available in the Raman workspace. 
When Dark Subtraction is enabled, it is performed prior to any Spectral Professing listed here. 
Irradiance Calibration and Reference Material Correction require a ratio file created by the factory. Relative 
Intensity Correction also requires a ratio file, but it is defined in Hardware Setup/ Probe Setup. 
Dark Subtraction should be used with Raman instruments; Relative Intensity Correction cannot be applied 
unless Dark Subtraction is done first. 
Additional Processing allows for multiple post processing steps to be applied after the intensity correction. 
This includes Baseline Removal, Smoothing, and Derivative. These functions are also available in 
Spectral Functions for post-measurement processing; refer to Section 9 for more details. 

 
Analytics 
This menu provides spectral analysis functions to be performed on the Processed Data block. 
The results are displayed in the Analytics tab which appears on the main form.  
The Peak Monitor allows the user to perform peak analysis on automatically defined peaks, and do 
arithmetic on the analysis results 
To define Measurements variables, select Basic Measurements or Derived Measurements. 
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Basic Measurements… 
Define the peaks property values 
Press the New button to add a new Measurement variable.  

The Name is to distinguish this measurement; this will be the title in Analytics. 
The Index will start at 0 and automatically increase for each additional measurement. 
The Type defines which peak parameter is being measured; Refer to Appendix C for a description and 
visual representation of Peak Property Values. Note BWSpec workspace shows all types available, while 
Raman only focuses on Raman specific types. 
The Source is always Dark Subtracted (Processed Data) in Raman workspace. You can also select %T/R, 
Absorbance, or Absolute Irradiance in BWSpec workspace 
Select Position specifies the x-axis unit used to select the peak: Pixel, Wavelength, or Raman Shift. 
Start and End - the highest peak found within the range defined by these two values will be taken as the 
peak.  
Delete: press this to delete the selected variable. A variable cannot be deleted if it is used to define one or 
more Derived Measurements. All such Derived Measurement variables must be deleted first. 
After the Experiment Setup is saved, the Analytics tab will appear in the top left of the main graph, where 
the measurements are displayed in a table. 

 
 

Derived Measurements… 
Define measurement variables that are derived from the Basic Measurements. Press the New button to add 
a new Measurement. 
The Name to identify this measurement; this name will be the title in Analytics. 
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The Index will start at 0 and automatically increase for each additional measurement. 
The Operation defines the type of math operation to be applied using Measurement A and/or B. 
The Measurement Type is chosen between Constant, Basic Measurement and Derived Measurement. 
For example, to measure the peak height ratio of peak A and Peak B, first define two Basic Measurement 
variables representing heights of peak A and B, then define a Derived Measurement variable as A/B. 

 
Timeline 
To perform kinetic measurements and analysis. 
Enable this function in the Plug-In Manager. 
The Timeline function provides automated, timed recording of acquired spectra within the scheduled time 
interval parameters set by the user.  
These spectra are then saved into individual files and are displayed individually in the main graph.  
If Dark and Reference spectra are taken before beginning timeline, they will be added to all additional 
timeline created spectra. 
Enter settings, including interval time (the delay 
time between each spectral acquisition), number 
of scans, file name suffix and/or file name prefix, 
data format for saved files and save path. 
The spectra collected will be saved in the 
designated path. If no specific suffix is assigned, 
a default of _1, _2, _3, etc. will be assigned to 
each spectrum. 
Refer to Section Timeline Plug-in for more 
details. 
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Raman Instrument Experiment setup example: 
Find and measure multiple peaks using a Probe, Relative Intensity Correction and Additional Processing. 
First, we are going to open Hardware Setup and setup the Probe information with the Relative Intensity 
Correction Ratio file. Then, we use that information in Experiment Setup and create an experiment to 
measure a Tylenol Tablet, apply baseline correction and smoothing, and find and measure a specific peak 
over time.  
Probe Setup 
Navigate to Setup => Hardware Setup and select the Probe Setup tab. 
Click the New button, and Probe Setup will appear. 
Enter an unique name for the probe, we recommend Probe_[Serial number of probe]_[Ccode of unit]; for 
example: Probe_160216952_RJX. This allows for a simple way to pair probes to instruments, especially if 
you have multiple probes. 
Select the radio button Select Ratio at Hard Drive and click the … button. 
Locate the Ratio3_[Ccode of unit].txt file, provided for you on the B&W Tek flash drive; for example; 
Ratio3_RJX.txt. 
The Ratio3 information will now be displayed, Click Done. 
Experiment Setup: Acquisition 
Navigate to Setup => Experiment Setup 
Under the Acquisition Section, in Probe, select the newly created Probe Profile; Probe_160216952_RJX. 
Select an Integration Time and unit suitable for your substance. You can determine optimal integration 
times by collecting data in the main window that gives the best spectrum for your sample; where the peaks 
of interest are at about 50,000 counts. 
Select an Average Number, 1 is typical, but more may be needed if you have longer integration times or 
low Signal to Noise Ratio (too much noise). 
Select a Laser Power % to use; 100% is good for white or light colored samples. Colored samples may 
use 60% and Dark colored samples may use 10-20% or lower. If you burn the sample, use a lower laser 
power and a longer integration time. 
Experiment Setup: Spectral Processing 
Under the Spectral Processing Section, Select the Correction Relative Intensity Correction. 
Check the box next to Enable Relative Intensity Correction. 
Check the box next to Additional Processing, and then click the button to open the Post Processing Setup 
window. 
Click New to add a Data Process. In our example we are going to do smoothing, 
Under Name we type in Smoothing, in Type we select Smooth, and under Smoothing Type we select 
Savitzky-Golay Smoothing with a window size of 2. Then click the Done button to add this Data 
Processing. Click Close to exit the window. 
Experiment Setup: Analytics 
Check the box next to Peak Monitor, and then click the button to open the Peak Monitor Setup window. 
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Click New to add a Basic Measurement. In our example we are going to measure the Tylenol peak height 
above the baseline at ~1324 Raman shift  
Under Name we type in Peak 1324, in Type we select Peak Height, and under Select Position we select 
RamanShift with a Start and End of 1314 and 1334 respectively. Then click the Done button to add this to 
Basic Measurements. Click Close to exit the window. 
Experiment Setup: Timeline 
Check the box next to Timeline, and then click the button to open the Timeline Setup window. 
Check the box Display Spectrum Overlay to have all the timeline acquisitions display in the main graph. 
Click the … to select a save location for the new data. 
Select the Delay time between spectra (ms), in this example we select 0. 
Select the Total # of spectra to collect, in this example we select 12. 
Click Set to accept the Timeline settings. 
Experiment Setup 
Click the Save Config button and save the experiment setup configuration to a .cfg file. 
Click the Close button at the bottom to close the Experiment Setup window. The main graph will adjust and 
display a dual chart for timeline, along with the Timeline Acquisition button and Analytics tab. 
Using the Experiment 
Click the Timeline Acquisition button     to begin taking data.  
The top graph will display each spectrum as an overlay. 
The bottom graph will display the Peak Monitoring (Peak Height in this 
case) as a function of time. To toggle different peaks, go to the Peak 
Monitor Panel at the bottom right and select the peak from the dropdown 
menu to activate the Measurement. 
At the top of the main graph the Analytics tab will record the Peak Height 
for each scan. 
To exit Timeline mode, go back to Experiment Setup and uncheck the 
Timeline box. Alternatively, you can go to Setup > Flash Access > Read Flash. 

 

 USB3 Spectrometer Reset   
This button is only available for USB 3.0 units such as the Exemplar series, i-Raman Plus, and i-Raman 
Pro. 
Performs a “Hardware reset” of the USB connection. This is functionally the same as unplugging and 
plugging back in the USB cable. 
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13  HELP  

Opens the BWSpec User Manual as a .PDF document.  

This .PDF is also available in the BWSpec installation folder location (C:\BWTEK\BWSpec). 

14  ABOUT 
The About window provides B&W Tek contact information  
BWSpec software version number. 
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15  TOOLBAR 
 

 Open 

 
Refer to function in menu File->Open Spectrum… 

 Save 

 
Refer to function in menu File->Save Selected Spectrum… 

 Print 

Refer to function in menu File->Print... 

 Excel 

Refer to function in menu File->Excel 

 Auto Save 

This is to enable/disable auto saving on scanned data 

 Integration Time Control 

 
Total Integration Time = Integration Time * Multiplier 
For Set Integration Time: Maximum Value is based on the Time Unit while minimum Value is based on the 
capability of the detector. Refer to product user manual for details. 
Unit 
Time unit for spectrometer acquisition time. 
Set to minutes (min), seconds (sec), milliseconds (ms), or microseconds (µs). Some units are not available 
in Raman workspace. 
Time Average 
Range 1 – 65535. 
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Average value will take the time average multiplied by the number of scans at the given total 
exposure time and display a single spectrum, which is the average of the x number of scans. This 
can be used to provide a spectrum with better S/N ratio. 

 Acquire Control 

 
Refer to Section 8 Acquire for more information. 

 Reset Graph           

Reset the graph to the default X-axis range for the spectrum and the Y-axis to the set scale. 
The set scale may be changed in   
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Display Scales. 

 Clear Display 

Remove all spectra from the Spectrum List Panel and display area. 
The same function as menu File->View->Clear All Spectral Data… 

 Display Scales 

Opens the Display Scales Settings window. 
The same function as menu File->View->Display Scales… 

 BAC151C Control     
Turns on the BAC151C Camera and opens a new View Window. 
The BAC151C Plug-in must be enabled in Plug-In Manager. 
Refer to the BAC151x User Manual for further details. 
Enables manual control of LED Illumination through checkbox under Acquire Control. 
Enables automatic control of LED Illumination during scans.  
If LED is on before any scan, the LED will turn off automatically during the scan, then back on when 
completed.  
If LED is off before any scan, the LED will stay off until manually turned back on. 
Enables the BAC151x button in Toolbar. 

Location: in the Menu Bar  Setup 
Refer to the BAC151x User Manual for details. 

Note: Disable this Plug-in to properly use spectrometers with built-in shutters. 

16  SPECTRUM LIST PANEL 
The Spectrum List Panel is located on the top-right side of the main screen after being activated. 
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Spectra listed are classified into two categories. The Measured Spectra refer to those acquired from an 
instrument, and Opened Spectra are those loaded from a folder. Measured spectra are numbered 
sequentially with a prefix “SP_”. 
Spectra with checkmark     are “Checked” spectra and are displayed in the graph. Spectra without the 
check marks are hidden from the current graph display.  
The spectrum highlighted with arrow (color may vary) next to its name indicates the spectrum 
currently selected. There can only be one Selected spectrum at a time. 
The “active” spectrum will have the current data overwritten if additional spectra are taken. 
A dark spectrum is used to subtract the contribution of the sensor itself. This is carried over until a new dark 
spectrum is acquired. 
To ensure data integrity, BWSpec prevents the measurement of a new spectrum when the last measured 
spectrum is unfinished, such as, when in Raman Workspace, the integration time of the signal and the dark 
spectrum are not the same. If the last Measured Spectrum has a raw and dark with different integration 
times, and an overlay is attempted, BWSpec will alert the user that the integration time of the raw and dark 
do not match. 
If the last Measured Spectrum is unfinished and is selected, it can be overwritten by a new measurement. 
No other spectrum can be overwritten by a new measurement. 
Right Click on individual spectrum from the list will bring up the following 
menu on the right→: 
Toggle the + sign to expand the information for a spectrum like below↓:  
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17  SPECTRUM INFORMATION PANEL 
Every spectrum from the list panel will have data displayed in the Spectrum Information Panel, including 
details of the selected spectrum’s acquisition parameters. 
Below is a short description of each entry: 

 
Name: Name of the spectrum in the Spectrum List Panel. 

 
DataSource: Spectrometer or Load File  

 
Model: Model Number. 

 
CCode: Configuration Code, related to Serial Number. 

 
PixelNumber: Number of pixels in detector. 

 
Average, Integration Time, Integration Time Unit; Details 
from the Toolbar. 

 
Laser Wavelength: For Raman only, otherwise set to default 
785 

 
Laser Level: Laser Percentage from the Toolbar. 

 
Probe Name: For Raman only, from Hardware Setup. 

 
HadTakeRaw, HadTakeDark, HadTakeReference: True or 
False depending on if the acquisitions are taken. 

 
Pretreat_X: Data processing (smoothing, baseline removal, derivative, spectral math) steps for the 
Processed Data block are saved here. 
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18  SPECTROMETER CONTROL PANEL 
 

The following sections are detailed descriptions of each item in the Spectrometer Control Panel. 
Each Workspace has default options in the Spectrometer Control Panel. Below is shown for the BWSpec 
Workspace. 

 
 
 
 
 
 
 

Additional display options 

Additional control options 
**Available options may vary depending on your 
spectrometer or system**  

Select desired Y-axis spectrum display mode.  

Select desired X-axis spectrum display mode.  
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 Enable Cursor 

This provides a vertical line on the graph which follows the mouse cursor. Information relating to the cursor 
location on the graph will be displayed at the bottom of the window in the status bar. 
This feature can only be used on a spectrum that is displayed on the graph while the instrument is not 
acquiring data. 
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 Dual Chart 

Select to simultaneously display Raw Data - dark (top) and a spectrum of your choice (bottom). 
 
 
 
 
 
 
 
 
 
 
 
 
 

 X Axis Unit 

Changes the X-axis display mode. 
 

 Y Axis Type 

Changes the Y-axis display mode. 
Raw Data: Shows raw form of the spectrum. 
Dark: Shows the Dark Array spectrum. 
Reference: Shows the Reference Array spectrum. 
Dark Subtracted (Processed): Starts as (Raw – Dark) without any spectral processing. All additional 
spectral processing applies to this Y-Axis instead of Raw, Dark or Reference. 
Transmission / Reflection (%): [(Raw– Dark) / (Reference– Dark)] * 100 
Absorbance: -log (Transmission (%) / 100) 
Absolute Irradiance: Shows the corrected spectrum when Irradiance Calibration is enabled. 
The spectrometer must have a valid Irradiance Calibration file. 
Refer to the Irradiance Calibration section for additional details. 
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 Acquisition Control 

 
 

External Trigger 
When enabled, the external trigger will have the following two behaviors depending on the setting in 
Hardware Setup: 
External Trigger Mode(default): 1 trigger pulse triggers all averages (a scan with 20 averages will need only 
1 trigger pulse); 
External Pacing Mode: 1 trigger pulse only triggers one average (a scan with 20 averages will need 20 
trigger pulses); 
Refer to the Hardware Setup section and the product user manual for additional details. 
 
Illumination LED 
This option appears when any BAC151x Plug-In is enabled. 
Manual control for LED illumination is available using the checkbox to toggle On/Off. LED Illumination will 
always automatically turn off during all Spectral Acquisition, including dark scan. 
 
Auto Time 
When enabled, the software will automatically scan and increase the integration time in increments until the 
response is close to saturation. 
Once the scan is complete, Auto Time will be enabled until it is disabled manually. 
This feature is meant to automatically find a suitable integration time for the given sample. 

 
Note: Additional control options may also appear depending on your spectrometer or system. Refer to your 
Spectrometer’s User Manual for more details.   
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19  STATUS BAR 
 
 
 

The Status Bar is located at the bottom of the main window. 
 

Online / Offline 
Shows status of spectrometer. 
Online – Spectrometer connected 
Offline – Spectrometer not connected, check USB cable and Device Manager. 

 
Scan count 
Increases in number with each scan.  
The box color will change red to pink with each scan:      → 

 
Acquisition status bar 
Increases as the scan progresses 
Useful for long integration times or multiple averages. 

 
Dark Array Status 
Gives status if a Dark Scan has been taken and saved into the Dark Array for the “active” spectrum. 

 
Reference Array Status 
Gives status if a Reference Scan has been taken and saved into the Reference Array for the “active” 
spectrum. 

 
Linearity Correction 
Gives status of the Linear Correction function 

 
Temperature 

 
Interlock 

 
Trigger 

“Waiting for trigger signal to start acquisition” message (may be cut off). 
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Appendix A: Declaration of TXTR File 

 
The TXTR (TXT Raman) text file has two block areas: flag block and data block. The flag block contains 
acquisition parameters and settings. The data block contains the acquired spectra data (highlighted by yellow). 
The flag block length may vary and an example of text file is shown below. 

1. TXTR has extra data blocks to store the intensity correction ratio spectra (including Relative intensity 
correction ratio, Reference Material Correction Ratio, and Absolute Irradiance Correction Ratio). This 
ensures the integrity of spectral files and makes it easy to transport and reprocess them without loss of 
critical information.  

2. TXTR added data processing audit trails to spectral file header to record the treatment steps for the 
Dark Subtracted (Processed Data) block starting from the Raw Data block. These are the numbered 
Pretreat lines and can be viewed in Spectrum List Panel. 

3. Users are recommended to use this new file format. 
4. File conversion utility can convert format between TXT and TXTR. 

 
File Format;TXTR     //File Format 
File Description;TXT(Raman) file //File Description 
File Version;BWRam4.11    //File Version 
Run Name;       //Custom defined Run Name 
Product Name;       //Custom defined Product Name 
Batch No;       //Custom defined Batch Number 
Lot No;       //Custom defined Lot Number 
Sample Supplier;     //Custom defined Sample Supplier 
Sample Notes;       //Custom defined Sample Notes 
Date;2017-05-24 01:22:41   //Date of File Creation 
title;NNN       //Spectrometer title name that saved data 
model;BRC112-FIT11     //Spectrometer model 
c code;NNN       //Spectrometer serial number 
operator;       //Operator that saved file 
pixel_start;0       //Sensor start pixel 
pixel_end;2047      //Sensor end pixel 
units;3        //X-axis unit (0=Pixel, 1=wavelength, 2=wavenumber,   
         3=Raman shift) 
show_mode;3       //Y-axis option (0=Raw,1=Dark,2=Reference,3=Dark Subtracted, 
         4=%TR, 5=Absorbance,6=Absolute Irradiance) 
data_mode;0       //Transmit data mode, 0=Binary, 1=ASCII (obsolete) 
pixel_mode;0       //Display Chart Mode .0=normal, 1=Pixel Monitoring (obsolete) 
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integration times(ms);1   //Spectrometer integration time of saved data     
integration times unit;1   //Spectrometer integration time unit setting (0=us, 1=ms, 
          2=sec, 3=min) 
time_multiply;1      //Spectrometer Integration time multiplier 
average number;1     //Number of spectral averages 
spectrometer_type;17    //Spectrometer model ID number 
yaxis;1       //Display Chart Y-axis Setting (0=Auto, 1=Manual) 
yaxis_min;0      //Display Chart Y-axis Minimum, if Y-axis setting is Manual 
yaxis_max;65535     //Display Chart Y-axis Maximum, if Y-axis setting is Manual 
xaxis;1      //Display Chart X-axis Setting (0=Auto, 1=Manual) 
xaxis_min;0      //Display Chart X-axis Minimum, if X-axis setting is Manual 
xaxis_max;2047     //Display Chart X-axis Maximum, if X-axis setting is Manual 
pixel_num;2048     //Sensor Pixel number 
coefs_a0;372.651160422713   //The coefficients (A0) of Pixel convert to Wavelength 
coefs_a1;0.273948279117576   //The coefficients (A1) of Pixel convert to Wavelength 
coefs_a2;-3.32083876761757E-05  //The coefficients (A2) of Pixel convert to Wavelength 
coefs_a3;-1.81673008524375E-09  //The coefficients (A3) of Pixel convert to Wavelength 
coefs_b0;-2649.51440443471   //The coefficients (B0) of Wavelength convert to Pixel 
coefs_b1;11.5617187502648   //The coefficients (B1) of Wavelength convert to Pixel 
coefs_b2;-0.0166223418721358  //The coefficients (B2) of Wavelength convert to Pixel 
coefs_b3;1.21997080526348E-05  //The coefficients (B3) of Wavelength convert to Pixel 
coefs_r0;1       //The coefficients (R0) of Pixel convert to Raman shift 
coefs_r1;0       //The coefficients (R1) of Pixel convert to Raman shift 
coefs_r2;0       //The coefficients (R2) of Pixel convert to Raman shift 
coefs_r3;0       //The coefficients (R3) of Pixel convert to Raman shift 
coefs_j0;1       //The coefficients (J0) of Raman shift convert to Pixel 
coefs_j1;0       //The coefficients (J1) of Raman shift convert to Pixel 
coefs_j2;0       //The coefficients (J2) of Raman shift convert to Pixel 
coefs_j3;0       //The coefficients (J3) of Raman shift convert to Pixel 
enable_coefs_r;0     //Use coefficient R0..R3 Enable. (0=Disable, 1=Enable) 
laser_wavelength;0     //Raman excitation wavelength (nm) 
laser_powerlevel;0     //Laser power level (percent) 
probe_index;0       //Probe index 
probe_name;       //Probe name 
dark_compensate;0     //Dark compensate Enable.  (0=Disable, 1=Enable) 
numcoeff_d;7       //The order number of linearity correction 
coefs_d0;0       //The coefficients (D0) of linearity correction 
coefs_d1;1       //The coefficients (D1) of linearity correction 
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coefs_d2;0       //The coefficients (D2) of linearity correction 
coefs_d3;0       //The coefficients (D3) of linearity correction 
coefs_d4;0       //The coefficients (D4) of linearity correction 
coefs_d5;0       //The coefficients (D5) of linearity correction 
coefs_d6;0       //The coefficients (D6) of linearity correction 
coefs_d7;0       //The coefficients (D7) of linearity correction 
irradiance_lamp_inttime;1   //int time used when creating irradiance correction ratio 
irradiance_lamp_unitindex;0  //lamp unit that used to crate irradiance correction ratio 
Color_Data_Flag;0     //data source for calculation color (0=%TR, 1=absorbance) 
Color_StartWL;400     //Start wavelength of calculation color 
Color_EndWL;700      //End wavelength of calculation color 
Color_IncWL;10      //Step wavelength of calculation color 
power_unit_index;1     //Color Unit[0=(W/nm), 1=(mW/nm), 2=(Uw/nm), 3=(uW/cm2/nm), 
         4=(uW/cm2/sr/nm), 5=(uW/sr/nm)] 
photometric_index;0    //Photometric Conversion (0=Photopic, 1=Scotopic) 
Illuminant_index;3     //Illuminant of color, (0=A, 1=B, 2=C, 3=D65, 4=E) 
observer_index;0     //Observer of color, (0=2 degree, 1=10 degree) 
lab_l;0       //Reference Color setting, l of Lab 
lab_a;0       //Reference Color setting, a of Lab 
lab_b;0       //Reference Color setting, b of Lab 
radiometric_flag;0     //Photometric or Photopic or Scotopic flag (0=Photometric, 
         1=Photopic, 2=Scotopic) 
Data Pretreat_0;     //Data pretreat process step 0 
Data Pretreat_1;     //Data pretreat process step 1 
Data Pretreat_2;     //Data pretreat process step 2 
Data Pretreat_3;     //Data pretreat process step 3 
Data Pretreat_4;     //Data pretreat process step 4 
Data Pretreat_5;     //Data pretreat process step 5 
Data Pretreat_6;     //Data pretreat process step 6 
Data Pretreat_7;     //Data pretreat process step 7 
Data Pretreat_8;     //Data pretreat process step 8 
Data Pretreat_9;     //Data pretreat process step 9 
Data Pretreat_10;     //Data pretreat process step 10 
Data Pretreat_11;     //Data pretreat process step 11 
Data Pretreat_12;     //Data pretreat process step 12 
Data Pretreat_13;     //Data pretreat process step 13 
Data Pretreat_14;     //Data pretreat process step 14 
Data Pretreat_15;     //Data pretreat process step 15 
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Data Pretreat_16;     //Data pretreat process step 16 
Data Pretreat_17;     //Data pretreat process step 17 
Data Pretreat_18;     //Data pretreat process step 18 
Data Pretreat_19;     //Data pretreat process step 19 
Data Pretreat_20;     //Data pretreat process step 20 
Data Pretreat_21;     //Data pretreat process step 21 
Data Pretreat_22;     //Data pretreat process step 22 
Data Pretreat_23;     //Data pretreat process step 23 
Data Pretreat_24;     //Data pretreat process step 24 
Data Pretreat_25;     //Data pretreat process step 25 
Data Pretreat_26;     //Data pretreat process step 26 
Data Pretreat_27;     //Data pretreat process step 27 
Data Pretreat_28;     //Data pretreat process step 28 
Data Pretreat_29;     //Data pretreat process step 29 
 
Pixel;Wavelength;Wavenumber;Raman Shift;Dark;Reference;Raw data #1;Dark Subtracted #1;%TR 
#1;Absorbance #1;Irradiance (lumen) #1;RelativeIntensityCorrection_Ratio #1; 
ReferenceMaterialCorrection_Ratio #1;AbsoluteIrradianceCorrection_Ratio #1;  
         //Header of data 
 
0;372.65;26834.75;-
26834.75;1227.0000;65535.0000;1339.0000;112.0000;0.0000;0.0000;0.0000;1.0000;1.0000;1.0000; 
    //pixel 0 data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 290020235-P    |   (9/10/24) Copyright 2024 B&W TEK Page 87 

 

Appendix B: Declaration of TXT File 
The TXT text file has two block areas: flag block and data block. The flag block contains acquisition parameters 
and settings. The data block contains the acquired spectra data (highlighted by yellow). The flag block length 
may vary and an example of text file is shown below. 
 
To read all data, the user should  

1. Find line “Pixel; Wavelength; Wavenumber; Raman Shift; Dark; Reference; Raw data #1;Dark 
Subtracted #1;%TR #1;Absorbance #1;Irradiance (lumen) #1”; 

2. Read from next line, it is the data of pixel 0 
3. Continue to read the next [pixelnumber-1] line 

 
File Version;BWSpec4.03_20_C  //BWSpec4 version that saved file 
Date;2015-07-16 19:56:56   //saved file date 
title;BRC112      //spectrometer title name that saved data 
model;BRC112      //spectrometer model 
c code;ABC       //spectrometer c code 
operator;       //operator that saved file 
port1;0        //port number if spectrometer is RS232 interface 
baud1;3        //baudrate index if spectrometer is RS232 interface 
pixel_start;0      //start pixel  
pixel_end;2047      //end pixel 
step;1        //the data index step  
units;0        //Spectrometer x-axis unit (0=Pixel, 1=wavelength,   
         2=wavenumber, 3=Raman shift) 
bkcolor;16777215     //Display Chart background color RGB value 
show_mode;0       //Spectrometer display option 0=RawData, 1=Dark, 2=Reference, 
         3=Dark Subtracted, 4=%TR, 5=Absorbance, 6=Absolute 
Irradiance 
data_mode;0       //Transmit data mode, 0=Binary, 1=ASCII (obsolete) 
pixel_mode;0      //Display Chart Mode 0=normal, 1=Pixel Monitoring (obsolete) 
intigration times(ms);1   //Spectrometer integration time of saved data 
average number;1     //Spectrometer average number of saved data 
time_multiply;1      //Integration time multiplier 
spectrometer_type ;17    //Spectrometer model id number 
yaxis;1        //Display Chart Y-axis Setting (0=Auto, 1=Manual) 
yaxis_min;0       //Display Chart Y-axis Minimum, if Y-axis setting is Manual 
yaxis_max;65535      //Display Chart Y-axis Maximum, if Y-axis setting is Manual 



 

 
 290020235-P    |   (9/10/24) Copyright 2024 B&W TEK Page 88 

xaxis;1        //Display Chart X-axis Setting (0=Auto, 1=Manual) 
xaxis_min;71      //Display Chart X-axis Minimum, if X-axis setting is Manual 
xaxis_max;1949    //Display Chart X-axis Maximum, if X-axis setting is Manual 
irrands_DispWLMin;100  //Display Chart X-axis Minimum, if X-axis setting is Manual and  
       show_mode=6 
irrands_DispWLMax;1000  //Display Chart X-axis Maximum, if X-axis setting is Manual and  
       show_mode=6 
yaxis_min_6;0    //Display Chart Y-axis Minimum, if Y-axis setting is Manual and  
       show_mode=6 
yaxis_max_6;0    //Display Chart Y-axis Maximum, if Y-axis setting is Manual and  
       show_mode=6 
irradiance_unit;0   //absolute irradiance data unit (0=W/cm^2/nm, 1=mW/cm^2/nm,   
       2=uW/cm^2/nm) 
Color_Data_Flag;0   //data source for color calculation (0=%TR, 1=irradiance) 
Color_StartWL;400   //Start wavelength of color calculation 
Color_EndWL;700    //End wavelength of color calculation 
Color_IncWL;10    //Step wavelength of color calculation in nm 
power_unit_index;1   //Photometry Power Unit [0=(W/nm), 1=(mW/nm), 2=(Uw/nm),    
       3=(uW/cm2/nm), 4=(uW/cm2/sr/nm), 5=(uW/sr/nm)] 
photometric_index;0  //Photometric Conversion (0=Photopic, 1=Scotopic) 
Illuminant_index;3   //Illuminant of color, (0=A, 1=B, 2=C, 3=D65, 4=E) 
observer_index;0   //Observer of color, (0=2 degree, 1=10 degree) 
lab_l;0      //Reference Color setting, l of Lab 
lab_a;0      //Reference Color setting, a of Lab 
lab_b;0      //Reference Color setting, b of Lab 
radiometric_flag;0   //Photometric or Photopic or Scotopic flag (0=Photometric, 
1=Photopic,       2=Scotopic) 
coefs_a0;732.046000000089   //The coefficients (A0) of Pixel convert to Wavelength 
coefs_a1;0.256049999999959   //The coefficients (A1) of Pixel convert to Wavelength 
coefs_a2;-4.90450000000253E-05  //The coefficients (A2) of Pixel convert to Wavelength 
coefs_a3;8.18407999999919E-10  //The coefficients (A3) of Pixel convert to Wavelength 
coefs_b0;-29079.7965557277   //The coefficients (B0) of Wavelength convert to Pixel 
coefs_b1;97.1304303120123   //The coefficients (B1) of Wavelength convert to Pixel 
coefs_b2;-0.111241614377263  //The coefficients (B2) of Wavelength convert to Pixel 
coefs_b3;4.46263025785099E-05  //The coefficients (B3) of Wavelength convert to Pixel 
coefs_r0;325.634643285781   //The coefficients (R0) of Pixel convert to Raman shift  
         (obsolete) 
coefs_r1;-0.371893845826952  //The coefficients (R1) of Pixel convert to Raman shift  
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         (obsolete) 
coefs_r2;0.000853220967122155  //The coefficients (R2) of Pixel convert to Raman shift  
         (obsolete) 
coefs_r3;3.37498265875635E-08  //The coefficients (R3) of Pixel convert to Raman shift  
         (obsolete) 
coefs_j0;-112.640169933252   //The coefficients (J0) of Raman shift convert to Pixel  
         (obsolete) 
coefs_j1;1.91244080985067   //The coefficients (J1) of Raman shift convert to Pixel  
         (obsolete) 
coefs_j2;-0.000774766051834558  //The coefficients (J2) of Raman shift convert to Pixel  
         (obsolete) 
coefs_j3;1.20204126521674E-07  //The coefficients (J3) of Raman shift convert to Pixel  
         (obsolete) 
enable_coefs_r;0     //Use coefficient R0..R3 Enable (0=Disable, 1=Enable) 
all_data_save;1      //all pixel data saved (0=No, 1=Yes) 
select_option;-1     //(obsolete) 
interval_time;1      //(obsolete) 
pixel_num;2048      //total pixel number 
sel_pixel_start;31     //start pixel for calculate RMS (obsolete) 
sel_pixel_end;2047     //end pixel for calculate RMS (obsolete) 
sel_pixel_delta;1     //interval pixel for calculate RMS (obsolete) 
dark_compensate;0     //Dark compensate Enable.  (0=Disable, 1=Enable) 
dark_compensate_value_1;0   //(obsolete) 
dark_compensate_value_2;0   //(obsolete) 
dark_compensate_value_3;0   //(obsolete) 
monitor pixel_0;0     //(obsolete) 
monitor pixel_1;0     //(obsolete) 
monitor pixel_2;0     //(obsolete) 
monitor pixel_3;0     //(obsolete) 
monitor pixel_4;0     //(obsolete) 
monitor pixel_5;0     //(obsolete) 
vertical_select_flag;0    //(obsolete) 
vertical_line3;0     //(obsolete) 
vertical_line4;0     //(obsolete) 
vertical_line3_wv;349.60   //(obsolete) 
vertical_line4_wv;349.60   //(obsolete) 
vertical_line_flag;0    //(obsolete) 
vertical_line_ratio;0    //(obsolete) 
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laser_wavelength;784.5    //Raman excitation wavelength, not used if enable_coefs_r=1 
laser_powerlevel;0     //laser power setting 
overlay_js;0       //(obsolete) 
Relative Intensity Correction Flag;0 //(obsolete/not defined)  
 
Pixel;Wavelength;Wavenumber;Raman Shift;Dark;Reference;Raw data #1;Dark Subtracted #1;%TR 
#1;Absorbance #1;Irradiance (lumen) #1; 
0;;;;1439.0000;65535.0000;1793.0000;354.0000;0.0000;0.0000;0.0000; //pixel 0‘s data 
1;;;;1439.0000;65535.0000;1793.0000;354.0000;0.0000;0.0000;0.0000; //pixel 1‘s data 
2;;;;1234.0000;65535.0000;1307.0000;73.0000;0.0000;0.0000;0.0000; //pixel 2 ‘s data 
3;etc. 
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Y Axis 

X Axis 
Peak Start  Peak Top 

 
Peak End 

Appendix C: Peak Property Values 
 
This is an overview of Peak Position and Properties, used in Peak Analysis and Peak Monitor Setup (Basic 
Measurement Type). Peak position is determined by curve fitting, instead of using the position of the highest 
pixel. This allows for a more accurate representation of the actual peak, and becomes more obvious when a 
peak lands in-between adjacent pixels - with one pixel usually being slightly higher than the other – and the 
peak calculated accordingly.  
In Peak Analysis, the peak is determined by the Minimum Absolute Height and Minimum Peak Width criteria. 
In Peak Monitor Setup, the highest point found within the Start and End Position will be taken as the peak.  
 
The following examples use a practical example of the 1236 cm-1 peak of a standard Acetaminophen (Tylenol) 
sample. The curve fitted peak position is 1236.374 cm-1, while the highest pixel is 1236.3 cm-1, refer to the close 
up of the peak. This peak was chosen because of its closeness to its neighboring 1257 cm-1 peak, giving an 
uneven looking peak to better visualize the peak picking algorithms. The 1257 cm-1 peak also gives a perfect 
example of a peak in-between two pixels. 
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Peak Monitor Setup’s Basic Measurement Type provides options for determining where on the peak to 
measure and what units are being measured. The Start and End of a peak is determined by the beginning rise 
of the peak compared to the baseline (left side), or the sudden rise of the next peak (right side). The Top of the 
peak is determined by curve fitting. Here is a simplified breakdown of the options; for example the Ramanshift 
Start gives the x-axis Raman Shift value of the beginning of the peak, and is found to be 1197 cm-1. 
 
Peak Start: The x-axis value of the beginning of the peak (left side). 
Peak Top: The x-axis value of the curve fitted peak position. 
Peak End: The x-axis value of the end of the peak (right side). 
Width: Subtraction of Peak Start from Peak End. 
Peak (Ramanshift): Gives the Raman Shift value (X Axis) 
Peak (Wavelength): Gives the Wavelength value (X Axis) 
Peak (Wavenumber): Gives the Wavenumber value (X Axis) 
Peak (Pixel): Gives the Pixel value (X Axis) 
 

Y Axis 

X Axis 
Peak Start  Peak Top 

 
Peak End 

Width 
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Peak FWHM: Full Width of the peak’s Half Maximum. Calculated beginning from half the peak’s height on each 
side, then the width of those half height values. 
Height: Y-axis value of Peak Top measured from the calculated baseline. 
Absolute Height: Y-axis value of Peak Top measured from zero. 
Height %: Peak height divided by the sum of all peaks height 
Absolute Height %: Absolute height divided by the sum of all peaks absolute height. 
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Absolute Height 
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Area: Area is defined by the Height (above baseline) and Width; blue shaded area. 
Absolute Area: Area is defined by the Absolute Height and Width; yellow shaded area. 
Area %: Area divided by the sum of all peaks Areas. 
Absolute Area %: Absolute Area divided by the sum of all peaks Absolute Areas. 
Fitted Curve X: Performs a fitted curve splining between the 2 set points and reports the center X value. 
Fitted Curve Y: Performs a fitted curve splining between the 2 set points and reports the center Y value. 
Manual Peak Area: Manually select the baseline removal points and calculated area start end end. 

Y Axis 

X Axis 

Absolute Area 

 

Area 
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Appendix D: Definition of Irradiance Data File Format 
Certified Standard Lamp data file example:  
 
Start WL=250   --------------------- starting wavelength (nm) 
End WL=2500   --------------------- ending wavelength (nm) 
Distance=50   --------------------- distance at which lamp data is generated 
units=mW/cm^2/nm --------------------- lamp data unit, choice of: W/cm^2/nm; mW/cm^2/nm; uW/cm^2/nm 
S-1169    --------------------- designation of the standard lamp (name, serial number …etc.) 
5     --------------------- starting flag  
250      --------------------- flag for starting wavelength (nm) 
2500     --------------------- flag for ending wavelength (nm) 
10      --------------------- increment of wavelength per data point  
0.760E-05   --------------------- standard lamp irradiance data at wavelength = 250 nm (250+0*10) 
1.788E-05   --------------------- standard lamp irradiance data at wavelength = 260nm (250+1*10) 
3.156E-05   --------------------- standard lamp irradiance data at wavelength = 270nm (250+2*10) 
….. 
….. 
 
3.795E-03   --------------------- standard lamp irradiance data at wavelength = 2500nm (250+225*10) 
5      --------------------- ending flag 
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Appendix E: Irradiance Ratio File Data Definition 
Ratio1_ccode.txt File details and explanation of data: 

RATIO1_ccode.TXT INFORMATION EXPLANATION 

BWSpec Version=BWSpec 4.04 Software Version used when the ratio file is created 

Irradiance Ratio File Version=1.0 Ratio File Version 

CCode=XXX or XXXX  C-code of Unit 

Int.Time=1100 Integration Time used when the ratio file was created  

Distance=75  Distance used for the ratio file creation from the calibration light source to the light input optics aperture  

Lamp Name=350-780.DAT  Name of Lamp Data File Used 

Lamp StartWL=350 Starting WL of Lamp Data File Used 

Lamp EndWL=780 Ending WL of Lamp Data File Used 

Lamp IncWL=10 Increments of WL interval from Start WL to End WL 

Lamp Measure Distance=75  Distance for which Lamp Data file was created 

Lamp Unit Index=2 Index 0 =W/cm^2/nm; Index 1 = mW/cm^2/nm; Index 2 = uW/cm^2/nm;  Units will match the Lamp Data file and the units of the irradiance data 

Lamp Coefs Order=7 Order of curve fit for Regression when creating the ratio file 

Coefs_C0=-102.802359649056 Curve Fit Values 

Coefs_C1=1.38796702045458 Curve Fit Values 

Coefs_C2=-0.00789398471358277 Curve Fit Values 

Coefs_C3=2.45424259313939E-5 Curve Fit Values 

Coefs_C4=-4.51571710685247E-8 Curve Fit Values 

Coefs_C5=4.93405335866037E-11 Curve Fit Values 

Coefs_C6=-2.9685358194907E-14 Curve Fit Values 

Coefs_C7=7.588143959E-18 Curve Fit Values 

irrands_yaxis_min=0 Y-axis minimum Display Scales Settings value 

irrands_yaxis_max=4.38087481104945 Y-axis maximum Display Scales Settings value 

irrands_DispWLMin=350 X-axis minimum wavelength Display Scales Settings 

irrands_DispWLMax=780 X-axis maximum wavelength Display Scales Settings 

start_wv_irrands=350 Start WL for Irradiance Calibration (should match Lamp StartWL) 

end_wv_irrands=780 End WL for Irradiance Calibration (should match Lamp EndWL) 

interval_wv_irrands=10 Increments of WL interval from Start WL to End WL (should match Lamp IncWL) 

Pixel    ;    Ratio    ;    Ratio Pixel number    ;    Ratio (Linearity Correction disabled)    ;    Ratio (Linearity Correction enabled) 

272;5.88055754188743E5;4.87368884634631E-5  

273;6.81553361643328E-5;5.60679388523222E-5  

274;7.19969136787624E-5;5.9194063207757E-5  
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